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This user manual describes mxGUI, Lawo's remote control software for the mc² console family.

The following products can be controlled using the current version of mxGUI.

mc²36 MKII and xp.
mc²56 MKIII.
mc²96 (all variants).

To ensure compatibility, the first three fields of the mxGUI and mc2 system software versions must match. Generally, it is 
recommended that all four fields match (to run identical versions). So, for example, if the mixing console is running 10.6.0.4, 
you will need mxGUI 10.6.0.x (mandatory) and 10.6.0.4 (recommended).

You can check the system software version from the Global Options in the System Settings display, and the 
mxGUI version from the Info window in the ? main menu.



https://confluence.lawo.com/pages/viewpage.action?pageId=128290058
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1 mxGUI - Introduction
mxGUI  (matrix GUI) can be used for remote operation or offline setup of any mc2  system. The application runs on an 
external computer that must be supplied by the customer.

The software works by running an emulation of the mc2  control system on a virtual Linux machine inside your host 
operating system. When you first start mxGUI, the computer boots the virtual machine and then the mxGUI application. 

From the product selection window, you can launch one of the mc2 emulations. You must choose the correct emulation (to 
match your system).

Once mxGUI is fully open, you will see the same displays as on the console's Central GUI. This allows you to make changes 
from the usual GUI displays. For example, to adjust channel parameters from the  Main Display, or edit labels and 
connections from the Signal List.

The screenshot below shows how mxGUI looks once the application is connected to a system.
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2 mxGUI - Installation and Setup
This chapter describes how to install and configure the software.

mxGUI - Prerequisites
mxGUI - Software Installation
mxGUI - Shared Folders
mxGUI - Product Options
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2.1 mxGUI - Prerequisites
mxGUI runs on an external computer that must meet the system requirements described below.

What you will need

To install the software, you will need a pre-installed virtual machine and the mxGUI-x-x-x-x.ova  file for the required 
software release.

For the virtual machine, please choose one of the options listed below.

The mxGUI-x-x-x-x.ova file is included (as standard) with the system software. The .ova file creates an appliance which 
runs within the virtual machine. The same file can be used with any of the virtual machine options.

To ensure compatibility, the first three fields of the mxGUI and mc2 system software versions must match. Generally, it is 
recommended that all four fields match (to run identical versions). So, for example, if the mixing console is running 10.6.0.4, 
you will need mxGUI 10.6.0.x (mandatory) and 10.6.0.4 (recommended).

Host Computer Requirements

The host computer MUST meet the following system requirements.

System Requirements

Any recent 64-bit processor. Intel or AMD CPU on Windows and Intel CPU on Mac.
At least 4GB RAM minimum/ 8GB RAM recommended.
A minimum of 2GB of available disk space for the appliance.

Windows PC

Operating System: Windows 10 or higher (32-bit and 64-bit).
Operation: Keyboard and mouse.
Interface: Ethernet 100/1000 Mbit/s.
Virtual Machine, one of the following:

Oracle VirtualBox 7 or higher.
VMware Workstation Player 17 or higher.
VMware Workstation Pro 17 or higher.

Mac

Operating System: MacOS 12 (Monterey) or higher.
Operation: Keyboard and mouse.
Interface: Ethernet 100/1000 Mbit/s.
Virtual Machine, one of the following:

Oracle VirtualBox 7 or higher.
VMware Fusion 12 or higher.

You can check the system software version from the Global Options in the System Settings display, and the 
mxGUI version from the Info window in the ? main menu.



In the current release, mxGUI's shared folders are NOT supported by VMware Fusion.

https://confluence.lawo.com/pages/viewpage.action?pageId=128290058
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2.2 mxGUI - Software Installation
There are two parts to the software installation: the virtual machine and mxGUI appliance.

For the virtual machine, please download and run the installer from the third-party provider.
Once you have installed the virtual machine, the next step is to import the mxGUI appliance.

The instructions below describe how to install the mxGUI appliance if you are using the Oracle VM VirtualBox Manager. The 
same principles can be applied to the other virtual machine options.

1.    Double-click on the mxGUI-x-x-x-x.ova file.

The VirtualBox Manager opens along with the 'Import Virtual Appliance' window and its suggested settings.

2.    Select Finish to import the mxGUI appliance, and Agree to accept the terms and conditions of the software license.

The import process can take a few seconds. Once complete, mxGUI-x-x-x-x is added to the list of virtual machines (on the 
left of the display).

At this stage, you can configure the Shared Folders (if they are required) or continue on to create a desktop icon (to start 
mxGUI).

3.    Right-click on the mxGUI-x-x-x-x virtual machine and select Create Shortcut on Desktop  to add an alias to your 
desktop.

4.    You can now close the Oracle VM VirtualBox Manager, and start mxGUI x.x.x.x from the desktop icon.

It is possible to install multiple versions of mxGUI on the same virtual machine. There is no need to uninstall or 
delete older versions.
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What happens next is described in mxGUI - First Steps.

If you need to re-open the VirtualBox Manager, then you will find it in your list of programs (or Applications).
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2.3 mxGUI - Shared Folders
mxGUI supports two shared folders: mxgui_user_share and mxgui_config_share.

The mxgui_user_share folder appears in both mxGUI and your host operating system. You will need this folder if you wish 
to copy user data from mxGUI to your operating system or vice versa (e.g. to transfer a production to a USB memory stick).

The mxgui_config_share folder stores the complete "Local Control System" for the mxGUI computer including the system 
configuration (i.e. the hardware definition and Signal List).

Configuring the Shared Folders

To provide access to the folders, you must define their file paths in the virtual machine. The instructions below describe 
how to do this if you are using the Oracle VM VirtualBox Manager. The same principles can be applied to the other virtual 
machine options.

1.    Start by creating two new folders in your Operating System named mxgui_config_share and mxgui_user_share.

You can choose any location on your computer, but the file paths must define the actual folder locations and not a short 
cut.

2.    Open the Oracle VM VirtualBox Manager and select the correct mxGUI virtual machine from the list on the left.

The mxGUI virtual machine must be powered off in order to create the folder links. If the machine is shown as "Powered 
On", then close mxGUI before continuing to the next step.

In the current release, mxGUI's shared folders are NOT supported by VMware Fusion.

Important: It is recommended to create a new set of shared folders for every major mxGUI release (to keep a 
backup copy of your user data and avoid any backwards compatibility issues in the future). In the example below, 
this is done by creating a new parent folder for each mxGUI release.





mxGUI - User Manual

Version: 10.8.0/1 Exported on: 9 April, 2024 11 /  45

3.    Click on Shared folders (in the Details area) to open the Shared Folder Settings:

4.    Select the + icon to define a new folder location, click in the Folder Path field and choose Other:

5.    Select the mxgui_config_share folder which you created in step 1 and click OK:

6.    Repeat steps 4 and 5 to define the file path for the mxgui_user_share folder.
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You should now have two Shared Folder entries:

7.    Select OK to confirm the changes.

When you next start mxGUI, the contents of the mxgui_user_share  folder can be accessed from the Productions → File 
Transfer display AND all data stored by mxGUI on its "Local Control System" is saved into the mxgui_config_share folder.

If you created a new set of folders (in step 1), then any existing user data can be copied across from the 
"mxgui_user_share" folder for the previous release.
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2.4 mxGUI - Product Options
When mxGUI first starts up, the 'Product Selection' window appears. To simplify the operation, some of the options can be 
hidden from view. For example, to show only console emulations of a certain type.

Product Options (default) Product Options (simplified)

Editing the Product Options

The current options are read from the "product_options.tcl" file when mxGUI starts up. By default, all options are included 
after a standard install. To make a change, you will need to edit and save the file, and then restart mxGUI.

To edit the file, you can use any suitable tcl file editor. The correct syntax for each product can be found in the 
"product_unified.tcl" file.

Note that the supported options vary depending on the mxGUI release. The screenshots below are taken from the V10.6.0.x 
release. Other mxGUI versions can be edited in a similar manner.

1.    Start by opening the "product_options.tcl" file in your tcl file editor.

The screenshot below shows the default file location.

If you have created a different mxgui_config_share file path (for a new mxGUI release), then it will be necessary to edit the 
new file or copy across the file from the previous release).



mxGUI - User Manual

Version: 10.8.0/1 Exported on: 9 April, 2024 14 /  45

The screenshot below shows the default contents of the "product_options.tcl" file (after a standard install). In this instance, 
nothing is suppressed and so all options will be visible in the 'Product Selection' window.

2.    Edit the file as shown below. For example, to suppress the mc2 36, mc2 96 and utility programs.

Make sure that you add the live entries after the # HEADER END. You can suppress individual entries or a complete branch 
of the menu (as in the example above).

The correct syntax can be copied from the "product_unified.tcl" file:

3.    Now save the "product_options.tcl" file.

4.    Then close mxGUI and the virtual machine (as described here).

When you next start mxGUI, the changes to the product options are applied.



mxGUI - User Manual

Version: 10.8.0/1 Exported on: 9 April, 2024 15 /  45

•
•
•
•
•

3 mxGUI - Operation
This chapter describes how to operate mxGUI once the software is installed and configured.

mxGUI - First Steps
mxGUI - Online and Offline Status
mxGUI - Operating Principles
mxGUI - Remote Operation
mxGUI - Offline Setup
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3.1 mxGUI - First Steps
This topic describes how to open and close mxGUI, and adjust the view (in the Virtual Machine).

Starting mxGUI

1.    The easiest way to start mxGUI is to double-click on the mxGUI-X-X-X-X desktop icon (created during the installation 
procedure).

Alternatively, you can open the VirtualBox Manager and start mxGUI either from the right-click options or Start button.

A window opens where you can see the boot-up of the virtual machine (e.g. VirtualBox) and then the application (Lawo 
mxGUI). This can take some time - the boot-up progress is shown on-screen.

2.    If you are starting VirtualBox for the first time, then you may see some additional messages that relate to the interaction 
between your computer's KVM interface and the virtual machine.

These vary depending on your host OS, and do not appear if they have already been suppressed for future start-ups. The 
examples below are taken from a Windows PC.

If the following (or similar) messages appear, then enable the option to suppress the message on future start-ups and click 
X to close.
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3.    At the following dialog box, click Do not show this message again (to suppress the message on future start-ups) and 
select Switch (to view the virtual machine in Seamless mode).

The view can be changed later (as described below).

4.    Once mxGUI has finished booting, you will see the 'Product Selection' window.

From here you can launch any of the mixing console emulations or a utility program. In each case, click on the arrows to 
view all available options. If you cannot see all of the options above, then they may have been edited (as described here).

Please note: it is important to choose the correct mixing console emulation (so that mxGUI shows the correct features and 
displays).

Product Selection Can be used for...

Mixing Console →

mc2 36 → mc2 36 MK2 → 16 Faders mc2 36 MKII console: 16C

mc2 36 → mc2 36 MK2 → 32 Faders mc2 36 MKII console: 16 (single faders) + 16C

mc2 36 → mc2 36 MK2 → 48 Faders mc2 36 MKII console: 16 (dual faders) + 16C
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Product Selection Can be used for...

mc2 36 → mc2 36 MK2 xp → 16, 32 or 48 Faders as above, but for the mc2 36 xp.

mc2 56 → mc2 56 MK3 mc2 56 MKIII console: all frame variants.

mc2 96 → mc2 96 mc2 96 console with standard centre section.

mc2 96 → mc2 96 Xtra mc2 96 console with extra faders centre section.

Utility Programs →

mxUpdater System software updates, user data backup and restore.

Image Creator Image backups for system and user data recovery.

4.   Make a selection (e.g. mc256 MK3) and click Start.

The mxGUI operating window opens and the software loads its warm start data (i.e. the settings saved at the last 
shutdown). The software is ready to use once you see the Signal List display. An example is shown below.

5.    Before moving on, it is recommended to adjust the size of the operating window.

Select the Maximize icon (at the top right of the display) to fit the mxGUI operating window to the virtual machine view.
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In Seamless mode, there is usually nothing further to do.

Changing the View

In VirtualBox, there are four possible viewing modes: Fullscreen, Seamless, Scaled or normal. 

Either Fullscreen  or Seamless  view are recommended as they scale the mxGUI operating window to fit your display.
Fullscreen uses the full screen available; Seamless view allows mxGUI to fit alongside other applications.

To change the view, press the correct keyboard shortcut (e.g. Host + L) to go back to normal mode (as shown below) and 
select an option from the View menu.
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Troubleshooting

In order for mxGUI to start correctly on a host PC, virtualization must be activated in the BIOS system. Follow the 
instructions below to enable this option.

BIOS Setup for a Windows PC

1.    Consult your PC's documentation for details on how to enter the BIOS setup.

2.    Look for the Virtualization option and set it to Enabled.

The screenshots below show two example systems.

3.    Remember to save any changes and then exit the BIOS.

4.    Restart the PC and then start mxGUI.
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When using mxGUI on mac OS-based systems with a retina display, it is necessary to adjust the resolution used by the 
macOS to run VirtualBox. Follow the instructions below to adjust the resolution.

OS Setup for a MAC with Retina Display

1.    Go to Applications, right-click VirtualBox and select Show Package Contents.

2.    Select Contents → Resources → VirtualBoxVM and press COMMAND + I (on the keyboard).

3.    Enable the option Open in Low Resolution.

The screenshot below shows an example system.
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Closing mxGUI

1.    To close the current emulation, select Application → Quit (from the main menus), or click on the close icon (at the top 
right of the display).

The emulation closes and the software returns to the 'Product Selection' window. If you are running offline, then the latest 
settings are saved to the local control system (on your computer).

2.    From here click on the close icon (top right) to close the software and the virtual machine.

This takes a few seconds, during which time, the progress is shown on-screen.

3.    When the virtual machine window closes, the shutdown is complete.
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3.2 mxGUI - Online and Offline Status
mxGUI has two modes of operation: online or offline.

You can interrogate the current status by hovering over the connection icon at the bottom right of the display.

In online mode, mxGUI connects to the mc2 control system via the IP network (and so you will see the IP address of the 
connected system). You can use this mode to remotely operate the system from the mxGUI displays. Any changes take 
immediate effect, and all user data is stored on the mc2 system.

In offline mode, mxGUI runs an emulation of the mc2 control system (and so you will see that mxGUI is connected to the 
"localhost"). You can use this mode to prepare settings offline, save them into a production (stored on the mxGUI 
computer), and then transfer this to the system at a later time. In this instance, all user data is stored locally on the mxGUI 
computer (on the "Local Control System").

Both modes are described in more detail later. For now, it is useful to know that:

By default, mxGUI starts in offline mode. You can use the Reconnect option (in the Settings → Connection window) to 
modify this behaviour.
A very basic configuration is included with the mxGUI installer (and this is why, initially, the offline Signal List  has no 
external signals).
Before you can build an offline setup that includes signal routing, you will need to open a online connection to the 
system (to synchronize the Signal List).
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3.3 mxGUI - Operating Principles

The mxGUI operating window is virtually identical to the Central GUI on an mc2 console, except for the main menus at the 
top of the display and some additional pages.

This topic describes the elements that are new to mxGUI users.

Main Menus
Available Pages
Adjusting Settings
Strip Assign display
Access/Assign window
File Transfer display
Shared Folder

Main Menus

In the current release, there are five main menus.

Page - provides access to the available pages.
Window → Access/Assign - opens the 'Access/Assign' window (to perform access/assign operations).
Settings → Connection - opens the 'Connection' window (to get online or offline).
Application → Quit – closes the current emulation.
? → Info – shows information about the mxGUI release.

Available Pages

Most of the mxGUI displays are identical to the ones on the console. You can learn more about these here. 

The exceptions are the Strip Assign and File Transfer displays which appear only in mxGUI. The File Transfer  display 
replaces the File display on the console GUI. It can be found under Production (as shown below).

To change page, click on the Page (main menu) or page icon (beside the Lawo logo). Or use one of the keyboard shortcuts 
(shown in the page menu).

Adjusting Settings

Settings are adjusted in the same way as on the Central GUI. Instead of touching an option, you can use the mouse and 
keyboard on your computer.

Left-click to enable a button or option.
Right-click to reveal the context menu (if applicable).
Left-click on a text field to edit a name.
Click on the up/down arrows beside a parameter, or use the keyboard up/down cursor keys, to adjust the value.

https://confluence.lawo.com/pages/viewpage.action?pageId=123406066#mc%C2%B256CentralGUI-SCREEN-CONTROL-Displays
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Strip Assign display

The Strip Assign  display provides a virtual representation of the console fader strips. You can use this to check what 
channels are assigned to the surface, select a fader and adjust levels and mutes.

1.    Open the display by selecting Strip Assign from the page menu.

The vertical "strips" represent the physical fader strips on the console. If you hover at the bottom of the display, a 
horizontal scroll bar appears. This can be used to scroll left and right to see all available faders.

2.    Working from top to bottom, each "strip" provides:

Strip # – identifies the fader strip. Note that main fader strips are marked as Main #.
Meter - channel meter. Right-click to change the meter mode or pick-up point.
Flip - layer flip. Click to switch to the alternate layer.
Sel - fader select. Click to select the fader strip (to change the channel in access).
Mute - channel mute. Click to mute the channel.
Level (in dB) & Fader - channel level. There are two ways to adjust the level.

Click on the dB field and type in a value or scroll the mouse wheel up/down.
Click and drag up/down on the fader.

Label - short label (identifies the channel). The labels can be switched globally using the LABEL buttons in the Access/
Assign window.

If you open the Access/Assign  window (as described below), you can use the Sel  buttons to change fader strip 
assignments, copy audio parameters, create a couple group, etc.

If you have a mouse wheel, then this can be used to adjust a parameter value, or scroll up/down a list, once it is in 
focus.

You can use any of the usual console Keyboard Shortcuts to speed up the page navigation and editing of 
parameters.



https://confluence.lawo.com/pages/viewpage.action?pageId=110985415#mc%C2%B256UsingtheConsoleKeyboard-Keyboard-Shortcuts
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Access/Assign window

The Access/Assign window can be floated above any of the main pages. It provides a virtual representation of the console 
centre section control panels. You can use this to perform a range of operations including strip assignment, bus 
assignment, and bank and later switching.

1.    Select Window → Access/Assign (or press CTRL + Q) to open the window.

This is a floating window and so its position can be moved as required.

In the example below, it is being used to perform a FIRST LAST fader strip assignment in conjunction with the Sel buttons 
on the Strip Assign display.

The on-screen controls work in exactly the same way as on the console front panel. Please click on the links below for more 
information about each function.

ACCESS – shows/selects the channel in access. See Access/Assign.
STRIP ASSIGNMENT - assigns channels to fader strips. See Fader Strip Assignment.
BUS ASSIGN - FADER – these are the FADER FORWARD Assign and FADER REVERSE Assign functions.
BANK and LAYER - switches Banks and Layers globally.
LABEL – switches the fader strip Labels.
COPY AUDIO – used to copy or reset audio parameters. See Copy & Reset.
LINK – used to create link or couple groups.
MODULE ISO – used to isolate DSP modules from snapshot loads.
SEL – replicates the SEL buttons on the Central Control Section. See Selecting Channel Parameters.
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File Transfer display

The File Transfer  display is used to transfer files between the local control system (on the mxGUI computer), the online 
system (if connected) and the shared folder (in your host operating system). It can be used to backup user data or prepare 
mxGUI for offline working.

1.    Open the display by selecting Production → File Transfer from the page menu.

On the left is the Local Control System (used when mxGUI is offline) and the Shared Folder (Host OS).

On the right is the remote control system (if a system is connected) and the Shared Folder (Host OS).

The remote control system provides access to the data stored on the mc2 system, and so this only appears when mxGUI is 
online. The system is identified by the Name and Primary IP entered in the 'Settings → Connection' window.

The Shared Folder (Host OS) appears on both sides of the display so that it can accept files from either the local or remote 
system.
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2.     Open or close directories by double-clicking on the directory name (or click on the arrow beside the directory name).

The data structure is the same for both the local and remote control system. They contain the following parent folders.

Active Production – contains the snapshots and mixes stored in the active production.
Productions – contains all zipped productions (as a complete file).
Presets – contains all module and channel presets.
Configuration – contains the custom function template files.
User Thumbnails - contains images for the user label thumbnails.

Each file and folder is clearly marked with its Type – e.g. production, channel preset, EQ preset, etc. The Type is important 
as files can only be transferred to a valid destination. For example, you cannot transfer a snapshot into 
the Automation folder!

It is possible to resize the display areas (by clicking and dragging on the vertical separator bar) OR sort files by Name or 
Type by clicking on the column headers.

3.    To transfer a file (or folder), select a valid source and destination. Then right-click, and select Transfer.

Transfers can be made from left to right or right to left. If an operation is not permitted, then the Export or Import option is 
greyed out. 

If a file with the same name already exists, then a copy is made and a suffix added to the file name. e.g. (0001).
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Shared Folder

The mxgui_user_share folder can be used to copy user data to and from your host operating system. For example, to 
transfer a production to a USB memory stick or make a backup of your system's user data.

To use this function, the folder must be defined within the virtual machine (as described earlier). The mxgui_user_share 
folder will then appear in both mxGUI and your host operating system.

Shared Folder (in mxGUI) Shared Folder (in Windows Explorer)

Operations in mxGUI

From mxGUI, you can perform some basic file management tasks.

1.    Right-click on the Shared Folder and select New Folder.

A new folder is added with a generic name.

2.    Type to rename the folder.

You can create folders within folders simply by right-clicking on the sub folder name.

3.    Right-click on the file or sub folder and select Delete. Then select OK to confirm.

Note that the Delete option is only available for files and folders in the Shared Folder.

To delete a file from the local (or remote) control system, you must open the relevant page. For example, to delete a 
production, open the Productions display; to delete a preset, open the Main Display; etc.

Operations in the Host OS

From your host operating system, you can perform any of the usual file management tasks: create folder, move or delete 
files, etc.

Note that each file has a specific file extension which should not be modified, otherwise the file cannot be loaded by the 
mc2 system. 
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File Types & Extensions

The import and export functions can be used to transfer any of the following file types. 

Note that it is not possible to transfer the Active Production or Presets folders. 

File Type File Extension Description

Production .lpn  This is a zipped file that must be transferred to/from 
the Productions folder.
The contents cannot be opened externally. To 
access individual elements, such as a snapshot or 
folder, you will need to load the production on the 
mc2 system and then open the Active Production
folder.

Snapshot Folder .lsf This is an individual snapshot folder (containing 
snapshots and cuelists). This is a zipped file that 
must be transferred to/from the Active Production
folder.
The contents cannot be opened externally. To 
access individual elements, such as a snapshot, you 
will need to load the production on the mc2 system 
and then open the Active Production and the 
Snapshot Folder.

Snapshot .lsn This is an individual snapshot file. It must be 
transferred to/from a Snapshot Folder in the Active 
Production folder.

Mix .lau This is an individual mix (containing mix passes). 
It must be transferred to/from the Active Production
folder.

Channel Preset .pch This is an individual channel preset. It must be 
transferred to/from the Presets folder.

EQ Preset .peq As above, but for the individual DSP modules. In each 
case, the module is described by the file type/
extension.Compressor Preset .pco

etc.

Complete Configuration Set .lcf This is a zipped file that is created when you transfer 
the Configuration folder. It contains all of the 
system's custom functions.
Note that the custom functions cannot be transferred 
individually and so this file is useful for global backup 
and restore purposes only.

User Thumbnail .jpg This is an individual user thumbnail image that 
complies with the permitted image requirements. 
For more information, please export and read the 
README.txt file contained in the User Thumbnails 
folder.
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File Type File Extension Description

Log .log This is a system logfile (visible only on the console's 
File display).
The logs can be useful for diagnostic purposes and 
should be exported and emailed to Lawo support 
should you encounter a system problem.
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3.4 mxGUI - Remote Operation
Online mode can be used to remotely operate a console from the mxGUI displays. In this mode, the software opens a 
connection to the remote system via the IP network. Once online, all changes take immediate effect and are made to the 
mc2 control system.

Please note:

mxGUI cannot connect to more than one system at a time. If there is an existing online connection, then this is cancelled 
automatically before a new connection is made.
It is possible to prepare several connections (to different consoles) as long as they use the same emulation.

Network Requirements

The mxGUI computer must be connected to the same management network as the mc2  control system. Connections are 
made via TCP/IP Ethernet.

You must use a network switch and NOT a hub, and keep the management network separate from other traffic within the 
installation. The switch should support 1GB for best performance.

Lawo delivers a suitable network switch with the system. This could be replaced by any other suitable switch fabric that 
provides comparable performance.

Depending on the number of network connections, one mc2 system can support up to 16 clients.

IP Settings

To establish a network connection to the mc2  system, you will need to configure the network settings for your PC's LAN 
port.

The IP Address must be unique and set within the same range as that of the mc2 control system (i.e. the first three fields 
must match). You can check the current settings for the system using the IP Address fields in the System Settings page.

The default IP addresses are:

mc2 36 = 192.168.102.36
mc2 56 = 192.168.102.56
mc2 96 = 192.168.102.96
mxGUI (local control system) = 192.168.56.101

The Subnet Mask should be identical to that of the mc2 control system.

The default subnet mask = 255.255.255.0

A Default Gateway setting is required if data packets are to be redirected. For example, if the computer is connected via a 
network switch with Layer 3 routing capability.

If redirection is not required, then the Default Gateway can be left blank.

To test the connection,  open a web browser application and enter the system’s IP address into the URL field. e.g. 
192.168.102.xxx - if the connection is successful, the mc2 landing page appears.

Opening a Connection to the System

The instructions below describe how to get online.

1.    Start mxGUI, making sure that you select the correct emulation.

2.    Select Settings → Connection from the main menus.

The 'Connection' window appears.

https://confluence.lawo.com/pages/viewpage.action?pageId=128290058
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This is a floating window and so you can move its position as required.

3.    Click on New to create a new connection.

A new entry is added to the list of connections and given a default name: New Host #.

4.    Optionally, you can edit the name by clicking on the Name field, or continue on to the next step.

5.    Enter the IP address(es) of the mc2 control system(s) into the Primary IP and Secondary IP fields.

If there is a redundant control system, then you must complete both fields. The Secondary IP is always one digit higher 
than the Primary IP.
If there is no redundant control system, then you can leave the secondary IP field blank or enter the same IP address 
into both fields.

In each case, type in the address and press ENTER to confirm. 

Default IPs (for redundant control system)

The connection is now prepared and you are ready to go online. At this point, you can repeat steps 3 to 5 to prepare more 
connections (for consoles of the same type/emulation).

Note that the current state of the 'Connection' window is stored when you close mxGUI and recalled when you next open 
the same emulation.

6.    To connect to a system, right-click and select Connect.

7.    An on-screen message appears - select OK to confirm (or Cancel to abort).

mxGUI now attempts to connect to the selected system. If the connection is successful, then the Status updates to show 
the "plugged in" icon.

If the connection fails, then the Status remains as "unplugged". In this instance:

Check the network cabling and TCP/IP settings of your computer's network interface card. 
Check that mxGUI is compatible with the mc2 system: same software versions and correct emulation.

8.    Once you have a valid connection, you can close the 'Connection' window and use the main pages to operate the 
system.
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Remember that mxGUI is now online and any changes are made immediately in real time!

Reconnecting to a System

If mxGUI loses its connection to the online system, then the Reconnect option determines what happens when the network 
returns.

Reconnect (off) - mxGUI stays offline until you right-click and select Connect (as described above).
Reconnect (on) - mxGUI automatically reconnects once a valid network connection is detected.

You can use Reconnect to deal with short interruptions to the network communication, or force mxGUI to connect 
automatically to a system after startup.

Disconnecting mxGUI

The instructions below describe how to disconnect mxGUI.

1.    Select Settings → Connection to re-open the 'Connection' window.

2.    Select the online system, right-click and choose Disconnect.

3.    An on-screen message appears - select OK to confirm (or Cancel to abort).

mxGUI disconnects from the system and the Status of the connection returns to its "unplugged" state.

In this mode, mxGUI is offline and any changes are made to the local control system (on the mxGUI computer).
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3.5 mxGUI - Offline Setup

In offline mode, mxGUI runs an emulation of the mc2  control system on the host computer. You can use this mode to 
prepare settings offline and then transfer them to the system at a later time.

When running offline, all user data is stored locally on the mxGUI computer (on the "Local Control System"). A very basic 
configuration is included with the mxGUI installer (and this is why, initially, the offline Signal List has no external signals). 
Before you can build an offline setup that includes signal routing, you will need to open a online connection to the system 
(to synchronize the Signal List). It is also a good idea to transfer a production from the mc2  system (to use as a starting 
point for the setup).

The recommended workflow is as follows.

Open an online connection to the mc2 system (to update the Signal List and transfer a production). This ensures that 
you have the correct external signals to work with and a useful production to load as a starting point.
Settings can then be edited and saved (offline) in the usual manner. For example, use the Production List to load (and 
save) a production, the Main Display to load (and save) a preset, etc.
Once the new files are prepared, they must be transferred back to the mc2  system either via the network (by going 
online) or via a removable USB device (using a file export/import).
The final step is to load the production or preset on the console.

The rest of this topic describes the main points in more detail.

What can be Configured Offline?

Anything that can be saved on a real system can be saved offline (onto the mxGUI local control system).

Productions, Snapshots, Cuelists and Mixes - as saved from the Productions, Snapshots, Cuelists and Mixes displays.
Presets – module or channel presets as saved from the Main Display.
Custom Function Assignments – the mapping of user buttons and other custom function assignments as defined in the 
mc²56 - Custom Functions display.

Compatibility

Productions can be loaded on any mc2 system. If there is a difference in the hardware configuration, then settings are 
loaded on a best-effort basis (as described below).
Presets can be loaded to any mc2 system regardless of the configuration.
Custom Function Assignments  can be transferred to any mc2  system. If the receiving system does not support the 
same User Panel, the custom function assignment can be edited from the Custom Functions display.

Where are the Files Stored?

The File Transfer  display provides access to the user data stored on the local control system. The parent folders are as 
follows.

Active Production – contains the snapshots and mixes stored in the active production.
Productions – contains all zipped productions (as a complete file).
Presets – contains all module and channel presets.
Configuration – contains the custom function template files.
User Thumbnails - contains images for the user label thumbnails.

Settings prepared offline are loaded on a best effort basis. So, for example, if the mc2 system has fewer DSP 
channels than the number configured, settings are loaded to the available channels. Similarly, if the signals in the 
Signal List are different, then only the ones with a matching ID can be configured.



https://confluence.lawo.com/pages/viewpage.action?pageId=110985966
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Preparing the mxGUI Computer

To prepare signal routing offline, it is important that the  Signal List  for the mxGUI emulation matches that of the mc2

system. If not, any settings which are specific to external signals will not load. The simplest solution is to open an online 
connection to the mc2 system. The HOME configuration will then automatically update the Signal List stored locally on the 
mxGUI computer. You only need to perform this operation once (providing there are no changes to the HOME 
configuration).

While online, it is a good idea to transfer a production from the mc2 system (to use as a starting point for the setup). This 
can be done from the File Transfer display as follows.

Open the File Transfer display.
On the left, select the Local Control System → Productions folder as the destination.
On the right, select the remote control system (via its name and IP) and open the Productions folder.
Right-click on the production you wish to import and choose Transfer - the production is copied from right to left.

File Transfer from online system (mc256) to mxGUI

Now open the Settings → Connection window and disconnect mxGUI from the mc2 system (to run offline).

Open the Production List and load the production (using either the Load button or right-click context menu).
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Production List (on Local Control System)

You are now ready to begin the offline setup.

Editing and Saving Settings

The instructions below describe how to deal with different types of user data.

Productions

It is recommended to modify an existing production if possible.

Use the File Transfer display to transfer a production from the online system (as described above). Then disconnect mxGUI 
and load the production from the Production List.

Once this is done, you can edit the parameters in the usual manner. For example:

To edit signal routing and labels, open the Signal List display.
To edit bus assignments, open the Bus Assign or Buses Reverse display.
To adjust the channel levels, open the Strip Assign display.
To edit the fader strip assignments, open the Strip Assign display and Access/Assign window.
To save different variants of a setup, save some snapshots and/or snapshot folders.

Once you have finished editing, remember to save all of the changes by saving or updating a production.

Presets

Module and channel presets are saved and loaded from the Main Display. They are stored on the local (or remote) control 
system as individual files in the Presets folder.

Custom Functions

Custom Functions are programmed from the Custom Functions  display. They are stored on the local (or remote) control 
system as individual files in the Custom Template Instances folder.

Snapshots and Mixes

Snapshots and mixes are managed in the usual manner. They are saved and loaded automatically as part of a production. 
They can also be transferred as individual files by loading the relevant production and making a transfer to/from the Active 
Production folder.
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Backing up the User Data

If you are going to prepare settings for a range of different systems, then it is a good idea to make a backup copy of the 
user data. This can be done using the shared folder that appears in both mxGUI and your host operating system. 

Use either the File Transfer  display or host OS to create a separate folder, inside the Shared Folder, for each mc2

system.
Then within each studio's folder, create a sub folder for productions, custom functions, etc. This allows you to keep all 
the relevant files together for each studio.
Now use the File Transfer display to make a backup copy of all relevant user data.

In the example below, the Shared Folder contains a sub folder for each console plus a generic folder for all presets.

Shared Folder (in mxGUI) Shared Folder (in Windows Explorer)

Transferring Data to the System

Having prepared a file offline, the final step is to transfer this back to the mc² system. This can be done either by going 
online (and using the File Transfer display) OR by using a USB memory stick (to export and import the data).

File Transfer

If you have a network connection to the system, then the first method is recommended. The instructions below describe 
how to transfer a production. Other types of file can be transferred in the same way; take care to select the correct 
destination folder in step 3.

Open an online connection to the mc2 system.
Open the File Transfer display.
On the right, select the mc2 system's Productions folder as the destination.
On the left, right-click on the production you wish to import and choose Transfer  - the production is copied to the 
system.
Now go to the console and load the production from the Production List in the usual manner - your setup is recalled!

USB Export/Import

If a network connection to the system is not possible, then you can use a USB memory stick to transport the file as follows.

Start by using the File Transfer display to copy the file from the Local Control System to the Shared Folder (Host OS).
Open the mxgui_user_share folder (in the host operating system), and copy the file to the USB device.
Now connect the device to one of the console's USB ports and import the file (using the File display on the console).
Load the production from the Production List in the usual manner - your setup is recalled!
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4 mxGUI - Utility Tools
This chapter describes the other utility tools that are included with mxGUI.

mxUpdater
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4.1 mxUpdater

The mxUpdater utility can be used to update the mc2 system software, or backup and restore its user data. In both cases, 
data is transferred to and from the mc2 control system via the Management Network.

Introduction

mxUpdater makes it easy to update your system whenever you install a new version of mxGUI. Note that it is only possible 
to update to the version that is concurrent with the mxGUI release. If you wish to update to a different version or 
downgrade the system, then you should use the auto update tool (described in the software release notes). 

Independently, mxUpdater can be used to backup all user data on the system so that it can be restored at a later time.

The diagram below shows the data structure in more detail.

Note that:

A software update affects only the System Flashcard (on the left), and does not alter any of your user data.
A backup or restore affects only the Data Flashcard (on the right), and does not alter the current software version 
running on the System Flashcard.
mxUpdater can be used to backup or restore the complete Data Flashcard only. If you wish to deal with individual files, 
such as a production, then use the File Transfer display (on mxGUI) or File display (on the console).

Prerequisites

To use mxUpdater, you will need to set up the two mxGUI shared folders (as described earlier) and have a valid network 
connection to the mc2 control system.

First Steps

mxUpdater can be started from the mxGUI 'Product Selection' window.

1.    Start by closing mxGUI to return to the product launch options.

2.    Select Utility Programs → mxUpdater and click on Start.
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The program opens with an empty window.

3.    Under "1 - Select Remote System", enter the IP address of the mc2 control system and click on Connect.

If you have connected to a system previously, then its IP address can be selected from the drop-down list.

After a successful connection you will see some information about the system in the mxUpdater window.

and the following files in the mxgui_config_share folder.

4.    You can now choose one of the following functions:

2. Backup Data - make a backup of the system's user data.
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3. Update System - update the system software.

4. Restore Data - restore the system's user data.

The rest of this topic describes each function in more detail.

User Data Backup

This function can be used to make a copy of the user data flashcard so that it can be restored at a later time. It is 
recommended to always save a backup before updating the software.

1.    Under "2 - Backup Data", select Backup.

2.    Enter a file name and then start the backup by clicking on Save.

Once the backup is complete, you will see the line DETAIL: Backup operation done in the "Log" area.

The backup file is stored on the mxgui computer in the mxgui_config_share -> mxupdater -> backup folder:

User Data Restore

At any time you can use one of your backup files to restore the system's user data.
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1.     Under "4 - Restore Data", select Restore.

2.     Select one of your backup files and click on Load.

3.    Confirm the restore by clicking on OK.

Once the restore is complete, you will see the line DETAIL: Restore operation done in the "Log" area.

Important: This operation will overwrite all existing data on the data flashcard, including productions and 
configuration files. Therefore, it is a good idea to make a backup of the current user data (as described above) 
before beginning a restore.
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mc2 Software Update

mxUpdater can be used to update the mc2 system to the version that is concurrent with the mxGUI release. Before using 
this option, it is recommended that you save a backup of all user data (as described above).

1.    Under "3 - Update System", select Update.

2.    Confirm the update by clicking on OK.

You will now see the progress of the upload, update and validation steps in the "Log" area. Once the update is complete, a 
system reboot is triggered:
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Note that the last few "Log" lines, including ERROR: Could not connect and ERROR: Update failed, remote aborted, are a 
result of the reboot. These lines are normal and can be ignored.

3.    After the reboot, the software update is complete.
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